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Creating Accessible PDFs During Formation in Word 
Microsoft Word is currently the most common word processor, so common, the .doc (and to a lesser 
extent, .docx) format has become the de facto format for text documents. Word is often used to 
create files that that are converted to PDF and placed in the web. Because of this the first step to 
creating an accessible PDF is to create an accessible Word document. This guide will cover several 
things that you can do to make PDF web documents, which are created in Word, more accessible. 

The First Questions to Ask 

What Version of the Software are you Using?  
The frustration or ease of creating accessible documents can hinge on whether you are using the 
latest version of the software. In the past couple of years there has been a large push by software 
makers, in particular Microsoft and Adobe, to fix issues related to creating accessible documents 
using their software.  

If you are using older versions of Word, in some cases it is impossible to make documents fully 
accessible, especially with Word for MAC. 

If you are committed to making accessible documents, it may be worth your while to invest in the 
latest version of both Microsoft Word and Adobe Acrobat. 

What Version of the Software was Your Document Created in?  
Documents made in older versions of Word (2003 and earlier) can cause a great deal of difficulty to 
remediate into an accessible document—depending on the content in them (such as tables). After 
reading through this document, you can follow the step below to convert them to an accessible 
document. 

1. Plan your new version (How will the new accessible version look? Does it need to retain the old 
look?) The more time spent in planning, the less time you’ll spend fixing the document later. 

2. Save a copy of the original. Give it a name such as doc-2-original. 
3. Open a Text Editor. 
4. Select and copy all of the content in the Original Copy. 
5. Then, paste the contents into the text editor. This action removes all previous formatting. 
6. Select and copy the text from the text editor.  
7. Open a new Word document. This is the time to choose a template. 
8. Then paste the text into the new Word file. Give the file a new name and save it. 
9. Apply Styles from the Styles Panel to give the unformatted document the look you want, and 

the structure it needs to be accessible. Because the new, plain text document lacks formatting, 
refer to the Original as a guide for determining structure and choosing styles.   



Set Options to Ensure PDF Documents are Tagged 

In order to create a tagged PDF from a Word Document you must check off the option in the PDF 
Options box: 

1. Click File,  
2. Click Save as.  
3. In the ‘Save as type’ drop down menu select PDF.  
4. You will see an ‘Options’ button at the bottom of the window. Select this Options button. 

 
5. An Options box will pop up.   
6. In the Options box check the box; ‘Document structure tags 

for accessibility.’  
7. Click OK.  

Please Note: You will only have to check this box once and all future 
PDF documents created from your Microsoft Word program will 
include your tags which you created for accessibility.  
 
 



Document Properties 

In documents that will be uploaded to the web, the Document Properties of ‘Title, Subject, and 
Tags’, must be added to the PDF. These document properties are used and displayed on the web by 
search engines such as Google. The title and subject also give a person using a screen reader a quick 
understanding about what the document is about.  

Adding these properties and checking to make sure they are accurate each time the document is 
changed and replaced on the web, is the responsibility of both the document creator and any future 
editors of the document. If these document properties are not checked and updated every time the 
document is added, changed, and replaced on the web then search engines may give people 
outdated information. 

To be able to add Document Properties to a PDF, you must first allow the document properties to be 
saved when converting a PDF from a Word Document.  

Allow Saving of Document Properties: 
1. Click File,  
2. Then Save as.  
3. In the ‘Save as type’ drop down menu select PDF (or preferably ‘Adobe PDF’ if you have 

the Adobe Acrobat Pro software and have added the plugin).  



4. Select the ‘Options’ button at the bottom of the window. 
5. An Options box will pop up.  
6. In the Options box check the box; ‘Document Properties’ You will 
only have to check this box once and all future PDF documents 
created from your Microsoft Word program will include your 
document properties.  
7. Be certain to leave the check in the box for ‘Document structure 
tags for accessibility’. 
8. Click OK. 

How to Check and Update Document Properties 
1. Click the File tab. 
2. Click Info to view the document properties. 
3. Hover your pointer over the Title property and click on it to update the information. Then do 

the same for Tags. 
4. Click ‘Show All Properties’ to find and update the Subject Property. 
5. Click the File tab again to return to your document. Any changes you made will be saved 

automatically.  



 
 
Language Settings 

Language settings are important for screen readers to read accurately. You can set a default language, 
and if you are using multiple languages in your document you should set the proofing languages for 
each. 

To set a Default language: 

 

1. Select the Review Tab to open the Toolbar 

 
2. Select Language 

 
3. In the drop down, select Language Preferences. 

 
4. The Word Options will open, in the Language tab 

 



5. Under the ‘Choose Display and Help Languages’ heading select English.

 
6. Click Set as Default.  

If several languages are used in the document,  

1. Highlight the passages of text and  
2. Select the Review Toolbar 
3. Select Language 
4. In the drop down select ‘Set Proofing Language’ and change the language for that passage 

of text.  

Headings 

A good heading structure is probably the most important accessibility consideration in most Word 
and PDF documents, and on Web pages. Headings will make the documents more usable for 
everyone and will allow screen reader users to navigate through the page easily.  



Headings are applied in the Styles panel on the Home tab.

 

Many people do not use true styles to create headings in Word. For example, when creating a 
heading, they simply change the font, enlarge the font size, and make it bold, etc. If this is done when 
creating an accessible document for the web, the document has no real coded structure that can be 
discerned by a screen reader.  

How to Create a Heading in Word 2013 
Word 2007 and later does a good job of encouraging the use of proper styles. About half of the 
Home toolbar is devoted to styles.  

To create a Heading: 

1. Type the text and highlight it.  
2. In the Styles panel on the Home toolbar click on the appropriate Heading style level. 

 

You can also add 1st, 2nd, or 3rd level headings using Ctrl + Alt + 1, 2, or 3 (Cmd + Option on a Mac). 

Use Hierarchical Structure 
Headings should be created in the 
document in a proper hierarchical 
structure. Use the Heading 1, Heading 2, 
Heading 3, Heading 4, and Heading 5 
styles as indicators of section headings 
and subheadings within the document. 
We recommend reserving Heading 1 for 
the page title, Heading 2 for major 
headings and Heading 3 for major sub 
headings. 

There are a couple of advantages of 
having true structure in Word 
documents. First, when the file is 
exported to HTML, it will retain the 
structure, making it accessible to screen 



readers. Second, the structure will also be retained when exported to PDF. In both cases, the added 
structure increases the readability of the document for people using screen readers. 

Customizing Heading Styles  

There are a many reasons why you may want to add some of your own customized styles to the Styles 
panel.  

1. You may want to personalize and design your document to your own color/font scheme while 
using recommended styles such as Heading 1, Heading 2 and others. 

2. Using Styles allows you to easily create table of contents 
3. Using styles in a document facilitates easy transition of content to PDF and preserves heading 

structure 
4. You can globally modify content by changing one Style setting. This includes modifications 

needed for a low vision student or a student with other reading/visual processing issues.  
5. In documents created in older versions of Word some themes do not automatically add the 

next heading style so you may want to correct this to allow you to use more than one or two 
headings 

Note: Before completely designing your own color/font scheme for headings you may find it easier to 
visit the Themes panel in the Design Toolbar. 

Hovering the mouse cursor over a theme will give you a preview of what your document will look like 
with that theme’s styles. 

To customize a Heading Style in Word 2013: 

Note: When designing your own color scheme true fonts are best for accessibility, and sans serif fonts 
are the best for web documents. All font sizes are required for accessibility to be a minimum of 10 pts. 

1. Highlight text and format using the Font tools in the Home tab. (You may use text that already 
has a heading style applied. 

.  



2. Find the heading Style you wish to customize in the Styles panel. If you do not see the Heading 
in the Styles panel, open the Styles Panel by clicking the arrow in the bottom right corner.

 
 

3. Then right click on the desired Heading and select "Update Heading to Match Selection." This 
will modify all the headings for this document.

 

Alternative Text for Images and Graphics 

Accessible documents must have proper Alternative Text (Alt Text) for all images. The Alt Text should 
describe to a vision disabled person using a screen reader what they need to know about the image. 
This is not the same as a caption. If a caption is used, the alt text is everything important a vison 
disabled person needs to know to understand the image that the caption does not already tell you. 

All Images that are not background should be given appropriate alt text in Word. This alt text will be 
read by a screen reader, and should remain intact when exporting to HTML or PDF. 

How to Add Alt Text to an Image in Word 2013  
 
To add alt text to an image: 

1. Right click on the image.  

2. In the popup menu select the 
Format Picture... option. The 
options for Formatting Picture 
will open on the right of the 
page. 



3. Select the Layout and Properties tab (see image on 
right). In Word 2010 and later Microsoft moved the 
place to add alt text back to an intuitive place, but 
made things even more confusing by creating two 
fields for alt text; a Title and Description.  

4. Add your alt text in the Description field. Note: 
Information in the Title field will not be saved as alt 
text when the file is saved as HTML. 

Constructing an Alt Text Description 
Alt Text should be constructed using human understandable language. It should not contain file 
names, filing information, document sizes, or color descriptions (unless the image is something like 
artwork where the color is used to convey a message.) 

Alt text should be as brief as possible while still giving the most important meaning for the image.  

If words are used in an image the alt text should contain all the words in the image. 

Images that have only text in them are a direct violation of Section 508. Instead use Styles for the text. 
This does not mean headings styles unless you want to weave the text into the structure of the 
document. Custom styles can be created in the Styles panel. 

Alternative Text for Embedded Charts 
Embedded charts should be given a text description within the context of the document itself. If you 
create an Alt Text description for the chart, the data that is used to create the chart will be accessible 
in the original Word file (it is basically a simple spreadsheet), but will not be included in a PDF when 
converted. Charts which are in documents intended for the web should have descriptions in the 
content of the document. 

Alternative Text for Word Art 
"Word art" is actually converted to an image in Office 2003-2007 and must be given alt text. It 
remains text in Office 2010 and later. 

Alternative Text for Images Using Word for MAC 
If you are using a MAC be aware that there is no way to add alt text to images in Word 2004 or 2008 
for MAC. 

 

  



Links 

Hyperlinks are frequently created incorrectly in Word by pasting the full URL into a page (e.g., 
http://www.necc.mass.edu/academics/programs/  and then hitting the ‘Enter’ key, space key, or some 
other key. This automatically creates a link. It's simple, but the URL will most likely not make sense to 
the reader.  

Using Link Text 
Hyperlinks placed in PDF documents on the web must be constructed using text to describe to people 
(especially people with disabilities, or others using screen readers), what the link is about and where 
they will be going to if they click it.  

Example Using Link Text:  

Good: NECC is now a member of the Kryterion International Testing Network. 
Bad: NECC is now a member of https://www.kryteriononline.com/Locate-Test-Center. 

Links should make sense out of context. DO NOT use phrases such as: 

• click here 
• more 
• read more  
• click for details 
• any single letter or number such as ‘A’ 

Examples: 

Good link text:  
Learn more by reading an article about the Knights in the NECC Newsroom 

Bad link text:  
If you want to learn more about this, click here. 

Keep link text brief. Do not be overly wordy by describing every detail about a link destination.  

Include File Types in Links 
If the link is to a document, it must include the file type, such as PDF, within the link text.  

Example: Application to NECC (PDF) 

Including ‘(Opens in a new window)’ in a Link 
In general links should never open to a new window, but for the occasional link to an outside website, 
if it opens in a new window you must include within the Link Text the exact phrase with parenthesis 

http://www.necc.mass.edu/academics/programs/
https://www.kryteriononline.com/
https://www.kryteriononline.com/Locate-Test-Center
http://www.necc.mass.edu/newsroom/2016/06/08/necc-knights-are-second-in-the-nation-2/
http://www.necc.mass.edu/newsroom/2016/06/08/necc-knights-are-second-in-the-nation-2/
http://www.necc.mass.edu/wp-content/uploads/2014/04/201408-002-Admissions-Application-with-insertA.pdf


“(opens in a new window)” This announcement should be placed at the end of the link. This will allow 
people using screen readers to understand what will happen if they click the link. 

Example: State of New Hampshire (opens in a new window) 

How to Add a Hyperlink in Word 2013 
1. Type the Link Text that you want to use for the hyperlink.  
2. Highlight the text. Right click and select Hyperlink.  
3. Add the URL in the Address. 

 

If you are creating a Word document that may be both printed and read electronically, you may want 
to include a description in the link text, and after it the full URL for print readers.  

How to Change the Hyperlink Text in Word 2013 
1. Select a link  
2. Right click and select Edit Hyperlink, or select Ctrl + K (Cmd + K on a Mac).  
3. Change the URL in the Text to Display field to Link Text that is more descript 

 

http://admin.state.nh.us/hr/employmentlisting.html


If you are creating a Word document that may be both printed and read electronically, you may want 
to include a description in the link text, and after it the full URL for print readers.  

Lists 

Any content that is organized as a list should be created using the List tools for ordered (numbered) 
and unordered (bulleted) lists that are provided in the Home Toolbar. When lists are explicitly created 
with these tools they are given list coding, which helps screen readers to understand how the content 
is organized. When screen reader users enter a list, their screen reader informs them that they’re on a 
list and may also inform them of how many items are in the list. This can be very helpful information 
when deciding whether to continue reading. 

Notes about Making Lists 
1. Avoid making lists with just dashes - or asterisks * or pictures for bullets; a screen reader may 

not be able to read the list in the proper order because there is no code to tell it what it is. 
2. Plain text bullets and numbers are more accessible than pictographic (fancy) bullets and 

numbers.  
3. Special characters and images can confuse screen reader users if the content is translated as a 

word that may make it seem like it is part of the real content.  
4. It is important to use the bullets provided through the list styling 

options because these characters are a type of text that can be 
translated into something meaningful by screen readers.  

Styling Lists 
It is a common mistake for people constructing lists to use the Enter key 
or spacebar to add white space around bulleted items. If extra spacing 
between list items is desired apply styles to the list. Do not hit the enter 
key multiple times then add an additional bullet. What is happening 
when you do this is you are creating multiple lists of one item, which is 
very frustrating for screen reader users. 

Data Tables and Accessibility Issues 

Tables can present a great deal a difficulty for people using screen readers to be able to access the 
information they need from them. If the tables are complex or poorly constructed, it can be almost 
impossible. In addition to being difficult for screen readers, tables can also be problematic to display 
well on mobile devices. For these reasons, tables should be avoided if there is another way to present 
the data. If you only need one or two rows it is likely the information can be presented with lists or 
paragraphs, and headings instead. If tables are used they should only be used for data, and not simply 
to format other content in a layout.  



With earlier word processors, it was common to create entire document layouts with tables. We now 
know that using tables for layout - solely to line things up conveniently - makes it nearly impossible 
for people who use assistive technologies to access the information. A table can be classified as a data 
table whenever you need to specify a row or column with header information about that row/column. 
If no informational header is needed, then it is a formatting layout table. 

To create accessible tables for the presentation of data, we need to keep them simple and follow a 
few simple procedures. 

Create an Accessible Table 
1. Open the Insert toolbar 

2. Select the Table drop down to open the options. 

3. Select the Insert Table button. Do Not insert the 
table by just selecting the columns and rows. Do 
Not select ‘Draw the table’. 

4. Enter the Number of columns plus 1 for the left 
header. So if you have 4 columns of data enter 5 
to include a column for the header. 

5. Enter the Number of rows plus 1 for the top 
header. So if you have 4 rows of data enter 5 to 
include a row for the header. 

6. Select a Fixed column width to make sure the 
table does not go beyond the page width. For 
some tables you may need to change the page 
orientation to landscape. 

7. Click OK.  

8. Give your table a title using the Caption tool: Select the entire table by clicking on the move 
handle of the table (found in the upper left corner of the table).   

9. Right click in the table to open the menu. Select Insert Caption. 



10. Enter the Caption for the Table. 

11. Set the Label field to table to make sure the 
label field indicates that this is a caption for a 
table.  

12. Set Position to ‘Above the selected item’.  

13. Click OK.  

14. The caption will appear over the table. 

Table 1 Schedule of Respiratory Info Sessions 

Date Time Location Room 
January 15, 2016 4:00 pm 414 Common Street LC 230 
February 12, 2016 1:00 pm 414 Common Street LC 300 
March 10, 2016 3:30 pm 78 Amesbury Street LA 218 

 
15. Next specify the header row and column of the table: Click anywhere in the table. 

16. Click on the Table Tools Design tab to open it.  

17. In the Table Style Options group, select the Header Row checkbox, and the First Column 
checkbox.

 

18. Next, you need to specify that the header row 
should repeat at the top of each page: click in 
the top header row. 

19. Right-click, and in the pop-up menu choose 
Table Properties 

20. Select the Row tab. 



21. Under Options, select box for ‘Repeat as the header row at the top of each page’. When 
converted to a PDF the headers at the top of the table will be tagged as headers for the table. 
Unfortunately, when converted to PDF the left column Header will not be tagged as a header 
column and must be tagged manually in Adobe Acrobat Pro. 

22. Click OK, and enter your data into the table. 

Things You Should Not Do with Tables 
• Do not use tables to create forms.  
• Do not have Blank Headers. Each Header cell should describe the data in the column or row. 
• Do not create Header Rows in the middle of the table. If you feel you need a new header row 

in the middle of a table, create another table instead. If this doesn’t work for you and you feel 
you absolutely must create a complex table like this, then each and every cell must contain 
unique IDs and header information. This can be a very time consuming process that must be 
done accurately, but be aware though that even if you successfully tag each cell the table may 
still be too complex to understand. Not every screen reader user is a power user that can 
manipulate the software to its maximum capacity. 

• Do not create your table using the Draw Table tool, which is available only with the Table tools 
on the Insert ribbon. 

• Do not create page layouts with tables. 
• Do not merge cells, and do not split cells. 
• Do not control spacing in your table with blank rows or columns. Adjust line spacing instead. 

Table Accessibility Issues with Conversion to PDF 
In PDFs converted from Word there is no way to assign table headers (or <th> elements) to rows of a 
table that will transfer on conversion to PDF. You can indicate that a top row should Repeat as header 
on the top of each page; in the Table Properties menu. When saved as PDF, the cells in the first row 
are detected as table headers for those columns. There is no way to add row headers (headers across 
the side of a table) in Word. 

Word 2013 Accessibility Checker 

Word 2013 included a new accessibility checker that allows you to check for accessibility problems. 
This is an excellent resource. The accessibility checker makes it much easier to identify and repair 
accessibility issues. 

 



To run the accessibility checker: 
1. Select File  

2. Select Info  

3. Click on Check for Issues 

4. Select Check Accessibility 

This will start the accessibility checker. The checker displays: 

• Accessibility errors such as images with no alt text  
• Warnings such as unclear link text  
• Tips like avoiding skipping from a first level heading to a 

third level heading 
• Feedback about the importance of each item 
• Tips on how to repair items  

Selecting an item in the report will select the corresponding 
item in the document. 
 
 

Other Principles 

In addition to the principles addressed above, most web accessibility standards can also be applied to 
files created in Word. The following is a list of a few other important accessibility principles: 

• Ensure that font size is sufficient, usually around 12 points or more. 
• Use simple language. 
• Provide a table of contents, especially for long documents. If you have a good heading structure, 

creating a table of contents is easy. 
• Provide sufficient contrast. 
• Don't use color as the only way to convey content. People that are color blind may not get the 

message, and colored text does not indicate importance to screen reader users. 
• Use true columns, not tables or columns created by hand with the Tab key. 
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